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Introduction to WinTelex32

WinTelex32, a SW Element of the PC-Telex Package from SWISSTELEX LTD, provides a complete solution
for Telex Message reception and transmission. In the same manner as using a classical teleprinter, you may call
the Telex exchange, connect to another Telex subscriber and carry out a dialogue conversation. This method of
operation is defined as Dialogue-Mode.
However, you may work much more efficiently if you use the WinTelex-Editor in order to prepare and store your

Telex Message, including the selection information, as a complete document. Using a built-in function of
WinTelex you may then have this document sent automatically. This method of operation is defined as
Automatic-Mode.
If you have prepared multiple documents for transmission, or if it is required to transmit these at a particular time
(deferred delivery), then you may use the WinTelex-Scanner in order to send such documents at the correct
time. This method of operation is defined as Scan-Mode.
Important: when displaying either incoming or outgoing Telexes, received text is presented in lower case whilst
transmitted text is presented in UPPER case.
Administration of the various files is facilitated using the WinTelex-File Manager. All documents are stored in an
intuitive folder system. The first nine folders are predefined and contain:
•
•
•
•
•
•
•
•
•

Outgoing Telex Messages (still to be transmitted)
Executed Telex Messages (successfully transmitted)
Faulty Telex Messages (Telex Messages which could not be transmitted)
Outgoing Record (what was sent on the telex line)
Incoming Telex Messages (not yet read)
Incoming and read Telex Messages
Templates (previously prepared documents with standardised formats)
Text Blocks (individual pre-stored text files, which can be imported by the Editor)
Lists (used to send a single document to multiple partners automatically)

In addition, the WinTelex-File Manager enables you to create as many other folders as you wish, e.g. archives,
templates, etc.
All incoming and outgoing Telex Messages are registered and stored in the folder system. The filenames are
constructed using sequential numeric series plus the DOS extensions ".IN " and ".OUT" respectively. The
appropriate counter is incremented after storage of every incoming or outgoing Telex Message.
Additionally, a Registration-Entry is written to the file History.log. History.log contains Information concerning
all executed transactions (type, direction, file name, date and time). The History.log file contains the entries for
the most recent telex calls. Older calls are to be found in History<nnnn>.log files (where <nnnn> is a number
ranging from 0000 to 1024). History files are cycled when they reach ~31 Kbytes. They are named with the next
free number in sequence (if any free number can be found) or the oldest History<nnnn>.log file is overwritten.
Note that numbers are not always in time sequence since operators might have removed old files in a non
sequential order. It is advised that you use a "sorting by date" to have your history files listed according to their
date & time.
The WinTelex-Number Register provides the possibility of storing the selection information required for
destinations accessed frequently.
In addition, by using the
mode).

icon, the previously selected Telex number can be recalled (only in dialogue

The definition of important parameters, such as the folders to be used and the start values of the file counters
are provided by program "WinTelex32 Configuration Administration" (Admin.exe, password protected).

Working with WinTelex
WinTelex32 Start and Termination
Starting the WinTelex32-Application
Click on Start and then select Program Files / WinTelex32 / WinTelex32.
The WinTelex32-Application control panel appears

and all available terminal windows are opened automatically.

Minimising and restoring the WinTelex32-Application
If the WinTele32-Application is active, it may be minimised to an icon in the SysTray and later restored as the
active window.
Adopt the following procedure:

•
•

to minimise: click the programs standard window minimise button
to restore: click the ”WinTelex32 ....” icon in the SysTray and click open

Terminating the WinTelex32-Application
In order to terminate the WinTelex32-Application: click

or click on the standard window close button

.

Opening a WinTelex-Terminal manually
If the WinTele32-Application is active:
click
If you have installed several Telex numbers on your PC (WinTelex32-Direct/-Dial) then you now have the
possibility to select the number that you wish to associate with the terminal window in use.
However, if ”WinTelex32 over IP” is installed you may open a new window with each click of the terminal window
icon (up to the maximum number of simultaneous connections).

If the WinTelex32-Application is not active, you may start the WinTelex-Terminal directly by clicking on Start and
selecting Program Files / WinTelex32 / WinTelex32.

Hiding and restoring the WinTelex-Terminal
Once a WinTelex Terminal is active, it may be hidden and re-displayed later using the WinTelex32-Application.
Adopt the following procedure:
•

to hide: click the programs standard window minimise button

•

to restore: select the appropriate window identification from the Windows Menu.
(e.g. Telex #: 911020 EDWS CH)

.

Terminating the WinTelex-Terminal
In order to terminate the WinTelex-Terminal:
select close from the Windows Menu or click the programs standard window close button.

Starting the WinTelex-File Manager
If the WinTelex32-Application is already active:
Select Telexfile-Manager from the Tools Menu or
click on the toolbar the symbol for the WinTelex-File Manager.
If the WinTelex32-Application is not active, you may start the WinTelex-File Manager directly by clicking on Start
and selecting Program Files / WinTelex32 / WinTelex32 File Manager

Hiding and Restoring the WinTelex-File Manager
If the WinTelex-File Manager is active, it may be minimised and later restored as the active window.
Adopt the following procedure:
•

to hide: click the programs standard window minimise button

•

to restore: select WinTelex–Manager from the Windows Menu.

Terminating the WinTelex-File Manager
In order to terminate the WinTelex-File Manager: select Close from the File Menu

Starting the WinTelex-Scanner
If the WinTelex-Terminal is already active:

select Scanner from the Tools Menu or
click on the toolbar the symbol for the Scanner
If the WinTelex32-Application is not active, you may start WinTelex-Scanner directly by clicking on Start and
selecting Program Files / WinTelex32 / WinTelex32 Scanner.
Note:
As well as the WinTelex-Scanner, the associated terminal window and WinTelex32-Application are also started.
Hiding and Restoring the WinTelex-Scanner
If the WinTelex-Scanner is active, it may be hidden and later restored as the active window.
Adopt the following procedure:
•

to hide: click the programs standard window minimise button

Note: when hiding the scanner the associated terminal window is also hidden.
•

to restore: select WinTelex Scanner from the Windows Menu.

Terminating the WinTelex-Scanner
In order to terminate the WinTelex-Scanner:
Click the command button "End Scanner". The WinTelex-Terminal now becomes the active window.

Telex Message Reception
When one or more Telex messages are resident in the TAG, you may retrieve these either with the WinTelexTerminal or with the WinTelex-Scanner.
Retrieval of Telex messages using the WinTelex-Terminal
In order to retrieve a Telex message using this program:

•

Select Receive from the File Menu or click the icon

In the event that further messages are available in the TAG, repeat the steps detailed above until the TAG
memory is empty.
In WinTelex Direct/Dial, if one or more Telex messages are stored in the TAG or TPI/S memory, these can be
uploaded on the PC (one message at a time starting from the oldest one) Every received messages is
automatically uploaded and stored in a regular Incoming Telex file.
For WinTelex over IP, this icon will start a new registration to the Internet Telex Gateways. If you have
subscribed to the Telex INSTORE service and messages are waiting in the INSTORE, the telex Exchange will
detect your presence and start to deliver them.

Retrieval of Telex messages using the WinTelex-Scanner
No special action is required. All messages resident in the TAG are automatically retrieved whenever the
WinTelex-Scanner is started.
As soon as the TAG memory is empty, the WinTelex Scanner may be terminated. Simply click the command
button "End Scanner".
With the help of the WinTelex-File Manager, received messages may be read and printed (Refer to Using the
WinTelex-File Manager)

Notes:
Messages retrieved using either of the above methods are placed in the folder "Incoming Telex". The files
stored in this folder are given a name consisting of a serial number (always the current value of the IN-counter)
followed by the extension .IN.
An option exists, whereby retrieved messages may be printed automatically to a specified system printer. If a
message has been printed a further option allows it to be placed directly in the folder "Incoming & Read Telex".
This procedure is recommended if you operate predominantly with hardcopy prints.

Telex Message Transmission using Dialogue-Mode
If you wish to operate using Dialogue-Mode then a WinTelex Terminal must be active. When the WinTelexTerminal window is open, the Toolbar contains buttons depicting the most important function keys of a classical
Telex teleprinter. A mouse click is sufficient to carry out the functions represented by these buttons.
The following buttons are indispensable when sending a Telex message in Dialogue-Mode:

Call.

Clear.

"Who Are You?" that is, request answerback of called party.

"Here is!" that is, transmit own answerback.

A message transmission could take place as follows:
1. By clicking

you commence the call
2. Using the keyboard enter selection information in order to determine the destination.
Terminate the selection information using the "+" key.
3. Wait until the answerback of the called party appears in the dialogue window, since this is provided
automatically.
4. By clicking

transmit your own answerback.
5. You may now enter the text of the message to be transmitted using the keyboard.
6. By clicking

you request the answerback of the called party.
7. By clicking

you transmit your own answerback once more.
8. Finally, by clicking

you clear the connection.
The answerback exchange at the end of the message, followed by clearing of the connection, serves to
conclude the transmission.

Additionally, once a connection is established, you may click the following buttons in order to:

transmit a text, prepared previously using the WinTelex-Editor.

transmit a "bell" signal.

transmit the current date and time.

Finally, by clicking

you may cause immediate disconnection of the call.
All characters still resident in the TAG memory are discarded and not transmitted. For example, the
repetitive test messages, generated by selection 180 or 181, can only be cleared using this method.

The WinTelex-Number Register offers an alternative method of establishing a dialogue call.

A message transmission could take place as follows:
1. By clicking

you call up the WinTelex-Number Register.
2. From the WinTelex-Number Register select the required destination.
3. Click the command button "Dial" in order to commence the call.
4. Wait until the answerback of the called party appears in the dialogue window, since this is provided
automatically.
5. By clicking

transmit your own answerback.
6. Clicking

allows you to transmit a prepared text. The Dialogue-Box "Send file" enables you to select
the file from which the text is taken. After selection, the symbol changes to:

and clicking this button will interrupt transmission of the selected text file.
7. By clicking

you request the answerback of the called party.
8. By clicking

you transmit your own answerback once more.
9. Finally, by clicking

you clear the connection.
The answerback exchange at the end of the message, followed by clearing of the connection, also
serves to conclude the transmission using this method.
Note:
In both cases you can use the WinTelex-File Manager (Outgoing Record Folder) in order to view and print the
just completed Telex message transmission (refer to Using the WinTelex-File Manager).

Telex Message Transmission using Automatic-Mode
In order to be able to send Telex messages automatically, the WinTelex Terminal must be active. Additionally,
at least one Telex message must be ready for transmission.
Normally, a Telex message prepared in advance for transmission is stored with a generic file name (*.tlx) in the
folder "Outgoing Telex ".
Telex messages can be prepared using the built-in WinTelex-Editor. It is important to note that the first line of
the text must consist of a number preceded by the symbol "#". (E.g. #911020).
Additionally, if an Answerback Check is required, the character string to be checked must also appear on the
first line, after the selection information, enclosed within square brackets.
Example: #911020 [911020 edws ch] (refer to: Telex Message with Automatic Answerback Check).
If it is only required to check parts of the answerback then the various strings should be separated using a
semicolon character, e.g. [911; edws]. This method is essential when the destination is a collective number.
e.g. using [911020; edws ch] will ensure that both of the following answerbacks are accepted: "911020a edws
ch" and "911020z edws ch".
After successful transmission, the file name is altered to (*.ok) and the "# " symbol is changed to an "@ "
symbol. These alterations prevent a Telex message from being transmitted a second time unintentionally.
Additionally, the file containing the successfully transmitted Telex message is moved from the folder "Outgoing
Telex " to the folder "Executed Telex".
Telex messages, which could not be transmitted successfully, receive a file name (*.err) and are automatically
moved from the folder "Outgoing Telex" to the folder "Faulty Telex".

If this message is the first one to fail (the first *.err message stored in the "Refused Telex" folder), the
icon will appear on the main WinTelex32 command panel to warn you that at least one telex message could not
be successfully tranmitted. If you click this new button, the WinTelex32 Telex File Manager will be opened and
the "Refused Telex" folder will be automatically selected.

A message transmission in this mode could take place as follows:
1. By clicking

you start the WinTelex-Editor from the WinTelex-Manager.
2. Using this built-in text processor, you can produce the Telex message (refer to:Using the WinTelexEditor).
3. Store the prepared message file in the folder "Outgoing Telex".
4. Select the command Exit from the File Menu in order to terminate the WinTelex-Editor.
5. By clicking

in the WinTelex-Terminal you initiate the transmission of a prepared Telex message.
You can select the folder and the file name of the document to be sent using the Dialogue-Box
"Send file".
6. You may observe the transmission of the Telex message in the Dialogue window.

You can use the WinTelex-File Manager (Outgoing Record Folder) in order to view and print the just
completed Telex message transmission (refer to Using the WinTelex-File Manager).

Telex Message Transmission using Scan-Mode
In order to be able to send Telex messages in this mode, the WinTelex-Scanner must be active. Additionally, at
least one Telex message must be ready for transmission. Normally, a Telex message prepared in advance for
transmission is stored with a generic file name (*.tlx) in the folder "Outgoing Telex".
The WinTelex-Scanner displays the various messages, which require processing in four sub-windows:
"To send"

contains those messages not yet transmitted (corresponds to the File Manager folder
"Outgoing Telex").

"Sent"

contains those messages transmitted successfully (corresponds to the File Manager
folder "Executed Telex". However, only those files with the DOS extension .ok are
displayed).

"Received"

contains those messages received, but not yet read (corresponds to the File Manager
folder "Incoming Telex").

"Error"

contains those messages which could not be transmitted (corresponds to the File
Manager folder "Faulty Telex").

As soon as the WinTelex-Scanner is started, it searches in the folder for outgoing Telex messages for files with
the extension ".tlx",".te?" or ".oc?", at regular intervals. This corresponds to the folder "Outgoing Telex ". The
value for the Time Interval, during which the Scanner waits between searches of the outgoing folder, may be
specified using the Setup-Menu, (the default value is 90 seconds).
Additionally, if an Answerback Check is required, the character string to be verified must appear on the first
line, after the selection information, enclosed within square brackets.
Example: #911020 [911020 edws ch] (refer to: Telex Message with Automatic Answerback Check).
Further, a deferred delivery time is also possible. When preparing a Telex message which should not be
transmitted until 02:30AM, then the required date and time, enclosed within round brackets, should be appended
to the selection information on the first line.
Example: #911020 (13/03/2007 02:30) (refer to: Telex Message with Deferred Delivery).
It is, of course, possible to specify both answerback check and deferred delivery. In this case, the answerback
check text should appear before the deferred delivery information.
Example: #911020 [911020 edws ch] (13/03/2007 02:30). Example Messages
Before each pass of the Scanner, it interrogates the TAG/TPI-S for received Telex messages. Since messages
may only be sent when no messages are resident in the TAG memory, the Scanner continues to request input of
received Telex messages, until the reception memory of the TAG/TPI-S is empty.
While the Scanner is executing it may be minimised to an icon, in order to work with a different application.
However, this may lead to certain problems if the application is so processor intensive that it can block the
processor. If the processor is blocked at precisely that moment in which the Scanner expects a reply from the
TAG/TPI-S, then the error message no reply from Modem may be generated (Since the reply from the
TAG/TPI-S was not received within the expected time by WinTelex).
A message transmission in this mode could take place as follows:
1. By clicking

you start the WinTelex-Editor from the WinTelex-Manager.

2. Using this built-in text processor, you can produce the Telex message
(refer to: Using the WinTelex-Editor).
3. Store the prepared message file in the folder "Outgoing Telex".
4. Select the command Exit from the File Menu in order to terminate the WinTelex-Editor
5. By clicking

you start the WinTelex-Scanner from the WinTelex-Terminal.
6. Minimise the Scanner to an icon and complete any outstanding tasks.
7. Periodically, after restoring the WinTelex-Scanner window, inspect the sub-window "To send". As soon
as no further entries are to be found in this window, then all attempts to transmit the Telex messages
have been completed.
8. Terminate the WinTelex-Scanner by clicking the command button "End Scanner".

You can use the WinTelex-File Manager (Outgoing Record Folder) in order to view and print the just
completed Telex message transmission (refer to Using the WinTelex-File Manager).

Using the WinTelex-Editor

The WinTelex-Editor is a built-in text processor that serves mainly in the preparation of Telex messages for
transmission. The page width of the WinTelex-Editor is synchronised to the maximum line length of a Telex
message (69 characters). Special help functions, such as the Character filter, the WinTelex-Number Register,
Textblocks and Address Lists are available.
The character filter
enables you to convert any text into a Telex compatible document. Incompatible
characters are converted to character strings. For example, $ and ä are converted to DLR and AE respectively.
The WinTelex-Number Register
prepared document.
Text Blocks

enables you to insert prestored selection information into a WinTelex

, which have been created previously, can be inserted. (see below - Text Block Creation).

Address List
. Enables the automatic creation of a file necessary when sending a message to a pre-stored
list of addresses, (see below – Address Lists).

Preparation of a Telex message ready for transmission
The text of a Telex message to be transmitted must conform to the following format:
1. The first line must contain the selection information, the answerback of the called party (optional) and the
date and time of transmission (optional).
Example:
#911020

[911020 EDWS CH] (13/3/2007 15:30)

This first line is not transmitted. [911020 EDWS CH] is an Telex Message with Automatic Answerback

Check
(13/03/2007 15:30) is a Telex Message with Deferred Delivery.
The called number and answerback, as well as the date and time, may be specified directly using the

Keyboard or taken from an entry in the WinTelex-Number Register.

2. The subsequent lines contain the text to be transmitted.
Example:
TO: F. DEMIERRE TELMEX AG
FROM: R. NUESSLI SWISSTELEX LTD
I HAVE RECEIVED THE LATEST VERSION OF WINTELEX.
MANY THANKS
BEST REGARDS
R. NUESSLI
The preparation of the message shown above could take place as follows:
1. By clicking from the WinTelex-Manager

you start the WinTelex-Editor.
2. By clicking
you start the WinTelex-Number Register.
3. In the WinTelex Number Register select the required selection information.
4. By clicking the command button "Insert into editor" you insert the selection information at the current
cursor position. The Number Register window closes automatically.
Note:
The cursor should be positioned at the first column of the first line.
5. Following the selection information, you may optionally insert the date and time of transmission using the
Keyboard. See: Telex Message with Deferred Delivery.
6. From the second line onwards, you may write the actual text of the message.
When using a previously prepared document from a Template folder, you may change from Insert Mode
(Ins) to Overwrite Mode (Ovr). This is accomplished by pressing the "Insert" key of the keyboard. The
change is displayed on the right, next to the Help Icon.
6a. By clicking
previously created Text Blocks may be inserted. (see below).
7. By clicking
you convert the entire text into a Telex compatible document.
8. By clicking
you open the Dialogue Box "Save file".

9. In the text field "Folder" select "Outgoing Telex".
10. In the text field "Extension" select "tlx".
11. In the text field "File name" type a name for the Telex message.
12. The required document is stored by clicking the command button "OK".
13. Select the command Exit from the File Menu in order to terminate the WinTelex-Editor and return to the
main "WinTelex-Application" window.
Text Block Creation
First, start the WinTelex Editor, as described above. Then, enter a name for the Text Block (e.g. Address,
Signature, etc.) as the first line of text. Enter the corresponding text on the second and subsequent lines. Finally,
save the new Text Block in the folder Textblocks, using an appropriate name (e.g. Name.blk).
Address Lists
In case you send Telex messages to the same multiple partners repeatedly, then you may create an address file
containing the corresponding Telex numbers. Each number should occupy a separate line of the file, e.g.:

911020 [911020; EDWS CH]
804306
05212345
911024
375106
etc.
Each entry in this list may be supplemented an Telex Message with Automatic Answerback Check and/or
a Telex Message with Deferred Delivery specification.
This file is stored in the folder ”Lists”. (e.g. “RoseLovers”).
If you wish to send a Telex to each address of this list then proceed as follows:
•

Prepare the Telex to be sent and save it in the Templates folder (e.g. "Rosesoffer").

•
•
•

Open the Editor and click
.
In the "Lists" window, select the file which you wish to use (e.g. “RoseLovers.tls”) and click "Open".
Subsequently, in the window "Templates", select the Telex message which you wish to send
(e.g. "Rosesoffer.msk") and click "Open".

The first line of your editor window should now contain a text with the following format:
L: List Name : File Name

(e.g..: L: RoseLovers : Rosesoffer).

For further functions of the WinTelex-Editor refer to: Commands and Symbols of the WinTelex-Editor
Note:
The WinTelex-Editor is started from the WinTelex-File Manager. (refer to: Using the WinTelex-File Manager)

Using the WinTelex-Number Register

The WinTelex-Number Register may be started from the WinTelex Terminal as well as from the WinTelex-Editor.
By clicking

you start it from the WinTelex-Terminal.
By clicking
you start it from the WinTelex-Editor.
The WinTelex-Number Register facilitates the following functions:
•

Insertion of called numbers, including answerback for verification.

•

Amendment of existing called numbers.

•

Deletion of existing called numbers.

•

Insertion of selection information in Telex messages to be transmitted.

•

Call and input of selection information in Dialogue-Mode.

Insertion of called numbers, including answerback for verification.
The insertion of called numbers is normally accomplished after the WinTelex-Number Register has been opened
from the WinTelex Terminal.
Proceed as follows:
1. By clicking

start the WinTelex-Number Register from the WinTelex-Terminal.
2. By clicking the command button "New" open the Dialogue-Box "New Item".
3. In the text field "Name" type the name (maximum 20 characters) used to identify the new destination
(e.g. TELMEX AG).
4. In the text field "Number" type the complete selection information (e.g. 911020).
Alphabetic characters may be used as well as numerals (e.g. bct 911020 804306).
5. In the text field "A/B Test" type the answerback to be used for verification before transmission of the
message text (e.g. 911020 EDWS CH).
Beware: Unless the text is identical to the answerback of the requested partner then a connection will
not be established. See: Telex Message with Automatic Answerback Check
6. By clicking the command button "OK" you close the Dialogue-Box and at the same time store the
selection information in the WinTelex-Number Register.
7. By clicking the command button "Exit" you close the WinTelex-Number Register and return to the
WinTelex Terminal window.
Amendment of existing called numbers
In order to make a change to an existing entry in the WinTelex-Number Register, proceed as folllows:
1. By clicking

start the WinTelex-Number Register from the WinTelex-Terminal.
2. Select the entry to be modified.
3. By clicking the command button "Change" you open the Dialogue-Box "New Item".
4. Amend the data appearing in this Dialogue-Box as required.
5. By clicking the command button "OK" you close the Dialogue-Box and at the same time store the
amended data in the WinTelex-Number Register.
6. By clicking the command button "Exit" you close the WinTelex-Number Register and return to the
WinTelex Terminal window.
Deletion of existing called numbers
In order to delete an existing entry from the WinTelex-Number Register, proceed as follows:
1. By clicking

start the WinTelex-Number Register from the WinTelex-Terminal.
2. Select the entry to be deleted.

3. By clicking the command button "Delete" you remove the selected entry.
4. By clicking the command button "Exit" you close the WinTelex-Number Register and return to the
WinTelex Terminal window.
Insertion of selection information in Telex messages to be transmitted
In order to insert selection information in a Telex message, proceed as follows:
1. By clicking

start the WinTelex-Editor from the WinTelex-Manager.
2. By clicking
start the WinTelex-Number Register from the WinTelex-Editor.
3. In the WinTelex-Number Register select the required destination.
4. By clicking the command button "Insert into editor" you insert the corresponding selection information
at the current cursor position. The Number Register window is closed automatically.
Call and input of selection information in Dialogue-Mode
1. By clicking

open the WinTelex-Number Register window from the WinTelex-Terminal.
2. In the WinTelex-Number Register list, select the destination to be called.
3. Click the command button "Dial" or double-click an entry in the list to begin the telex call.

Using the WinTelex-File Manager

All documents are stored in an intuitive Folder system.
The first nine folders are predefined and named as follows:
"Outgoing Telex"
"Executed Telex"
"Faulty Telex"
"Outgoing Record"
"Incoming Telex"
"Incoming & Read Tlx"
"Templates"
"Textblocks"
”Lists”

(still to be transmitted). (Name.tlx, .te? and .oc?)).
(successfully transmitted). (Name.ok).
(Telex messages which could not be transmitted). (Name.err or .no).
(what was sent on the telex line). (xxxx.out).
(Telex messages still to be read). (xxxx.in).
(received Telex messages which have been read). (xxxx.inr).
(previously prepared documents with standardized formats). (Name.msk).
(Pre-stored text files may be saved here). (Name.blk).
(Pre-stored address lists may be saved here). (Name.tls).

These nine folders are permanently installed and support the system procedures. They can neither be modified
nor deleted.
Default Folder:
If one of the folder names appears followed by the sign "(*)", it has been established as your default folder. The
default folder is the one proposed for Open/Save operations. You can establish your default folder by
clicking its name with the "Shift" key pressed (Shift + Click).
Notes:
All incoming (*.in or *.inr) and transmitted Telexes (*.out) are associated with a key (MD5 Fingerprint), which
enables subsequent modifications to be detected. These Telexes are also write protected.
Normally, the text of messages is displayed in the rightmost window of the WinTelex-Manager with a green
background. In case a message has been altered the background colour changes to red. If messages exist
from a previous version of WinTelex then these are displayed with an orange background, since they have no
associated key.
Abnormal telex messages also have a warning text displayed. If the Telex message is printed then this warning
is also printed.
If you wish to edit such a message it must first be copied to a different folder.

The most important functions of the WinTelex-File Manager are to:
•
•
•
•
•

Provide source documents for the WinTelex-Editor.
Delete documents.
Copy or move documents.
Create new folders or modify and delete existing folders.
Print documents.

In all cases you must first start the WinTelex-File Manager.
Provide source documents for the WinTelex-Editor
In order to provide a source document for the WinTelex-Editor, proceed as follows:
1. In the folder list, select the required folder (e.g. "Incoming & Read Tlx").
2. In the file list of the selected folder, select the file name of the required document.
3. Using "Drag & Drop" or by clicking

you start the WinTelex-Editor with the required document as source.
Delete Documents
In order to delete one or more documents, proceed as follows:
1. In the folder list, select the required folder (e.g. "Faulty Telex").
2. In the file list of the selected folder, select one or more file names of the documents to be deleted.
3. Using "Drag & Drop" or by clicking

generates a request for confirmation of the deletion.
4. After your confirmation, the deletion is executed. In case the folder is located on a local hard disk, the
deleted documents are actually moved to the 'Recycle Bin'.
Copy or move documents
In order to copy or move one or more documents, proceed as follows:
1. In the folder list, select the required folder (e.g. "Faulty Telex").
2. In the file list of the selected folder, select one or more file names of the documents to be copied or
moved.
3. Using "Drag & Drop" or by clicking

.

you open the Dialogue-Box "Copy/move files".

4. Select the option button "Move" if you wish to move documents, "Copy" if you wish to copy documents or
"Archive" if you wish to archive documents (for archival you need an external archive program (e.g.
PKZIP.exe) which is not included in the WinTelex package).

5. Select, from the destination folder list, the required destination folder (e.g. "Outgoing Telex").
6. By clicking the command button "OK" you execute the copy or move procedure for the required
documents.
Create new folders or modify and delete existing folders
In order to create a new folder, proceed as follows:
1. By clicking

you open the folder directory.
2. By clicking the command button "New" you open the Dialogue-Box "Create new folders".
3. In the text field "Title" type the name of the new folder (e.g. Archive).
4. In the text field "Directory" type the DOS directory name to be used for this folder (e.g. a:\archive)
5. In the text field "Extensions" type the DOS file name extension(s) to be used when selecting files for
display (e.g. "*" for all file names or "tlx;oc?" for outgoing messages).
6. By clicking the command button "OK" you complete the creation of the new folder.
7. By clicking the command button "Exit", you close the folder directory and return to the WinTelex File
Manager.
In order to modify an existing folder, proceed as follows:
1. By clicking

you open the folder directory.
2. Select the entry in the folder directory that you wish to modify.
3. By clicking the command button "Change", you open the Dialogue-Box "Change folders"
4. You may now alter one or more of the various text fields.
5. By clicking the command button "OK" you update the entry in the folder directory.
6. By clicking the command button "Exit", you close the folder directory and return to the WinTelex File
Manager.
In order to delete an existing folder, proceed as follows:
1. By clicking

you open the folder directory.
2. Select the entry in the folder directory that you wish to delete.

3. By clicking the command button "Delete" you execute the delete procedure.
4. By clicking the command button "Exit", you close the folder directory and return to the WinTelex File
Manager.
Print documents
In order to print one or more documents, proceed as follows:
1. In the folder list, select the required folder (e.g. "Executed Telex").
2. In the file list of the selected folder, select one or more file names of the documents that you wish to
print.
3. Using "Drag & Drop" or by clicking

you execute the print procedure.

Subject Field
If you click either on the Menu Subject or on the column header "Subject=" in the "List of Files" then a
dialogue box is opened, which allows the input of a text string.
The input text is now used as a search criterion in order to determine all of those Telex messages containing this
text which are resident in the selected folder. If a message is found containing the specified text then the 15
characters following this text are displayed in the "List of Files" under the column heading "Subject=".
Whether a text is in upper or lower case is irrelevant.
e.g. :

COMPANY:

(The column header changes to: "Subject=COMPANY:")
"COMPANY:" is any arbitrary character string.

General Note:
If there are very many documents in the folder being searched, it may take quite some time before the search is
complete.

Commands and Symbols
Commands and Symbols of the WinTelex32-Program

opens a terminal window. If several Telex numbers are installed (WinTelex32 –Direct/-Dial), you must first
select the required Telex number from the list of available numbers. If "WinTelex32 over IP" is installed then
each click of this symbol opens a new terminal window, up to the maximum number of simultaneous connections
available.

starts the WinTelex-Manager. If several Telex numbers are installed (WinTelex32 -Direct/-Dial), you may
select the required Telex number from the list of available numbers. The Manager also provides the possibility to
switch between available Telex numbers.

advises that at least one Telex message could not be transmitted. Clicking this symbol starts the
WinTelex-Manager with the folder "Faulty Telex" already open.

advises that at least one Telex message has been received, but has not yet been read. Clicking this
symbol starts the WinTelex-Manager with the folder "Incoming Telex" already open.

starts WinTelex Help. Alternatively, click Menu Help and select Contents.

terminates WinTelex32. A warning message is displayed in the event that the Scanner is still active.
allows you to determine whether the reception of a Telex message should cause an
audible alarm to be generated (green background) or not (red background). This option may be set individually
for each available Telex number. It is also possible to select between 15 different sounds by clicking Properties
and selecting Telex Survey/Ring Sound and the appropriate number.
allows you to determine whether the reception of a Telex message should cause a
warning message to be displayed on the monitor screen (green background) or not (red background). This
option may be set individually for each available Telex number.

provides the possibility of (temporarily) silencing all audible alarms. The background colour of
"Alarm Sound On/Off" changes to red. If this option is de-activated background colour returns to its previous
setting.
Only for IP connectivity and activated by SwissTelex in the event that you are unable or not allowed
to open a firewall for incoming connections.
If active, the scanner will make repeated outgoing connections, at regular intervals, in order to retrieve any
message which INSTORE is unable to deliver directly.
By clicking Properties in the Menu bar and selecting Language the working language may be set to 'English',
'Deutsch', 'Français' or 'Italiano', i.e. English, German, French or Italian.
Protection of WinTelex32 with a password:
By clicking Properties in the Menu bar and selecting Set/Change WinTelex Password the WinTelex32program may be password protected.
DO NOT LOSE this password as clearing or redefining it is a complex operation which will require that you
contact the Telex Support Personnel (who will provide you with instructions and with a single use password).
Please keep this password in a SAFE place and do not write it down in any easy to find location !

Commands and Symbols of the WinTelex-Terminal

or menu Line/Open
Begin call. This corresponds, in telephony, to "Receiver off-hook".

or menu Line/Close
Clear the connection to the exchange, respectively "Receiver on-hook".

(no menu command)
Clear connection immediately.

or menu Terminal/Send...
A prepared text with selection information on the first line is transmitted automatically (Automatic- and ScanMode). When using Dialogue-Mode the prepared text is transmitted directly over the existing connection.
The file to be transmitted can be chosen using the Dialogue-Box "Send file".

(no menu command)
This button is visible if the terminal accepted an Incoming Telex Call. You can enter conversational telex mode
by pressing this button. The text window is locked until this button is pressed. Please note that calls answered in
this manner are not saved in the “Incoming Telex” folder but directly into the “Incoming & Read Telex” folder
(since somebody did answer the call, no incoming telex alarms will be raised).

or menu Terminal/Receive
For WinTelex Direct/Dial, If one or more Telex messages are resident in the TAG/TPI-S memory, these may be
downloaded to the PC (One message at a time and always the current "oldest" message). Every received Telex
message is automatically stored as a disc file.

For WinTelex over IP, this button will initiate a registration call to every Internet Telex Gateway. If the subscriber
has applied for INSTORE service and if any messages are kept in the Telex Exchange INSTORE, they will be
delivered (starting in the next few minutes) after this button is pressed.

or menu Terminal/Number-register
The WinTelex-Number Register used for automatic call setup or insertion of selection information with the Editor.
Numbers may be inserted, modified or deleted.

or menu Tools/Scanner
Telex-Scanner. The "Outgoing Telex " folder is searched, at predefined intervals, for valid outgoing Telex
messages ( *.tlx and *.oc? ). Any found are automatically transmitted. Incoming Telex messages are also
automatically downloaded and stored. This function is also used for the network "Telex-Server" utility.

or menu Commands/Date/Time
Transmit the current date and time.

or menu Commands/Bell
Transmit a "bell" signal (Beep with TAG-Modem).

or menu Commands/Your A/B
Request the answerback of the called party.

or menu Commands/My A/B
transmit your own answerback.

or menu Line/Redial
Repeat the call to the last selected Telex number.

Commands and Symbols of the WinTelex-File Manager

or menu File/Edit as well as (Drag&Drop)
Start the WinTelex-Editor.

or menu File/Delete as well as (Drag&Drop)
Delete one or more selected files.

or menu File/Copy/move as well as (Drag&Drop)
Copy or Move one or more selected files.

or menu File/Folder mutation
This allows private folders to be created, modified or deleted.

or menu File/Print as well as (Drag&Drop)
Print one or more selected files.

(no menu command)
As long as this symbol appears, the folder "IncomingTelex" still contains unread Telex messages. Clicking this
symbol causes the first (newest) Telex message from this folder to be presented for inspection using the
WinTelex-Editor. The Telex message is also automatically moved to the folder "Incoming & Read Tlx". It is not
necessary to quit the Editor in order to inspect the next Telex message, simply click the symbol again.
menu Help/Contents to start the WinTelex help.
If several Telex numbers have been installed, this 'drop-down' list provides the possibility
of switching between the individual numbers.

If you wish to change the document sort order, simply click on either of
the column headings "File name" or "Date". However, if you click on the heading "Subject=" then a dialogue box
is opened. This enables the input of a text string to be used as a search criterion, in order to determine all of
those Telex messages containing this text which are resident in the selected folder. If a message is found
containing the specified text then the 15 characters following this text are displayed in the "List of Files" under
the column heading "Subject=". Be aware that this is a processor intensive operation and that if there are very
many documents in the folder being searched, it may take quite some time before the search is complete.

This option is only available when it has been specifically activated (See Automatic User Abbreviation Insertion),
otherwise the option buttons are not even displayed. According to the option selected, either all documents in
the folder are displayed in the "List of files" or only those associated with your user abbreviation.
Default Folder:
If one of the folder names appears followed by the sign "(*)", it has been established as your default folder. The
default folder is the one proposed for Open/Save operations. You can establish your default folder by
clicking its name with the "Shift" key pressed (Shift + Click).

Commands and Symbols of the WinTelex-Editor

or menu File/New
Create a new document using the WinTelex-Editor.
or menu File/Open...
Open an existing document for processing with the WinTelex-Editor.
or menu File/Save as well as File/Save as...
Store a document on disc in the Folder system.
or menu Edit/Cut
Delete a selected portion of text from the document and place it on the clipboard.
or menu Edit/Copy
Copy a selected portion of text from the document and place it on the clipboard.
or menu Edit/Paste
Paste the contents of the clipboard into the document at the current cursor position.
or menu Edit/Delete
Delete a selected portion of text from the document.
or menu File/Print...
Print the document currently being processed by the WinTelex-Editor.
or menu Edit/Keyfilter
Convert the current document to a message conforming to Telex conventions.
or menu Edit/Insert number...
Insert, at the current cursor position, selection information taken from an entry in the

WinTelex-Number Register.
or menu Edit/Textblocks
Insert a previously prepared Text Block at the current cursor position.
no menu command
Starts the process of generating a file required to send a previously prepared document to a pre-stored list of
addresses.
or menu Help/Contents
Start WinTelex help.
Ins/Ovr Shows whether the current status of the editor is insert mode (Ins) or overwrite mode (Ovr).

Example Messages
Telex Message in Automatic-Mode
#911020
TELEX-MESSAGE IN AUTOMATIC-MODE
BEST REGARDS
SWISSTELEX LTD
HHHH

Telex Message in Automatic-Mode with Answerback Check
#911020

[911020; EDWS CH]

TELEX-MESSAGE IN AUTOMATIC MODE WITH ANSWERBACK CHECK
BEST REGARDS
SWISSTELEX LTD
HHHH
Note:
[911020; EDWS CH] is an Telex Message with Automatic Answerback Check

Telex Message in Scan-Mode using Deferred Delivery without Answerback Check
#911020 (13/03/2007 16:15)
TELEX-MESSAGE IN SCAN-MODE USING DEFERRED DELIVERY WITHOUT
ANSWERBACK CHECK
BEST REGARDS
SWISSTELEX LTD
HHHH
Note:
(13/03/2007 16:15) is a Telex Message with Deferred Delivery

Telex Message in Scan-Mode using Deferred Delivery with Answerback Check
#911020 [911020; EDWS CH] (13/03/2007 16:15)
TELEX-MESSAGE IN SCAN-MODE USING DEFERRED DELIVERY WITH
ANSWERBACK CHECK
BEST REGARDS
SWISSTELEX LTD
HHHH

Note:
[911020; EDWS CH] is an Telex Message with Automatic Answerback Check
(13/03/2007 16:15) is a Telex Message with Deferred Delivery

Telex Message in Automatic-Mode with MEMO-PLUS 132+
#132
ZCZC
MSG.NR 001
A+
BT

TELEX-MESSAGE WITH MEMO-PLUS 132+
--------------------------------TEST MESSAGE ACCORDING TO MEMO-PLUS DESCRIPTION AND OPERATING
INSTRUCTIONS 3.2. FOR AUTOMATIC EMITTING DEVICES - AUTO-SEND-MODE.
BEST REGARDS
SWISSTELEX LTD
++++

Telex Message in Automatic-Mode with MEMO-PLUS 133+
#133
ZCZC
MSG.NR 001
A B C+
BT
TELEX-MESSAGE WITH MEMO-PLUS 133+
--------------------------------TEST MESSAGE ACCORDING TO MEMO-PLUS DESCRIPTION AND OPERATING
INSTRUCTIONS 3.2. FOR AUTOMATIC EMITTING DEVICES - AUTO-SEND-MODE.
BEST REGARDS
SWISSTELEX LTD
++++

Telex Message in Automatic-Mode with MEMO-Telex 144+
Message preparation (in Automatic-Mode).

#144
ZCZC
MSG.NR nnn
911020+
BT
WE CONFIRM YR TLX...
++++
Broadcast call (in Automatic-Mode).

#144
ZCZC
MSG.NR nnn
375101
...
...
...
375110+
BT
WE CONFIRM YR TLX...
++++

Services provided by SWISSTELEX LTD

TELEX-Subscriber Facilities
The following special facilities are offered to all Telex subscribers. SWISSTELEX LTD Direction accepts
registrations and provides further information, if required.
TAX : Notification of call duration.
On completion of every outgoing call, the Telex exchange provides the call duration expressed in minutes
and seconds.
Selection format: TAX 911020+

BCT : Broadcast call.
The "Broadcast call" facility allows the simultaneous transmission of a message to several destinations:
maximum 10 national or 5 international destinations. It is possible to combine both address categories.
However, from the total of 10 allowed destinations a maximum of 5 may be international. (e.g. 2 international
and 8 national).
Selection format: BCT 911020 840301 02312345+

MLT :Broadcast call using prestored list.
The Telex exchange provides the capability of storing up to 4 lists, each containing a maximum of 10 called
numbers, which may be used regularly for broadcast calls. The facility is invoked by input of the selection
code "MLT" followed by the required list identifier. The system now establishes connections with the
required destinations automatically. The number of international destinations in a list is subject to the same
restriction as "BCT".
This facility must be subscribed separately.
Selection format: MLT 1+

K : Abbreviated Dialling.
The Telex exchange is able to store abbreviated dial codes. It is possible to enter one or two digit dial codes
in place of long selection sequences or for frequently called destinations (e.g. "K 12" instead of
0257104563434). The Telex exchange ensures that the complete selection sequence is used to establish
the call. Each subscriber may have up to 16 abbreviated dial codes, each corresponding to a selection
sequence of up to 15 digits.
This facility must be subscribed separately.
Selection format: K 12+

U: Account subdivision.
The charges for automatic Telex traffic are normally totalled and invoiced as a single figure. However, the
facility "Account subdivision" permits this total to be split into sub-totals according to one of 8 short codes

entered with the selection. This allows the Telex costs to be ascribed to individual departments.
This facility must be subscribed separately.
Selection format: U D 911020+

D: Direct call.
Should a Telex connection be used exclusively for the transmission of messages to a unique destination,
then it is possible to have the selection information for this destination stored by the Telex exchange. As
soon as the call signal is recognised by the Telex exchange, it will establish the connection to the required
destination automatically.
This facility must be subscribed separately.

D+Z: Notification of date and time.
The facility "Notification of date and time" provides precise information concerning when an outgoing or
incoming message was transmitted or received. The Telex exchange provides this information automatically
after termination of every connection.
This facility must be subscribed separately.
Telex INSTORE service (For WinTelexIP subscriber ONLY)
Subscribers who do not have permanent Internet connection (e.g. Dial-up or semi-permanent access) are
normally unable to receive telexes during the periods when they are not connected to the Internet or when all
their connections are occupied. Such subscribers may elect to make use of a SwissTelex telex exchange
facility called INSTORE, which accepts telexes when the subscriber is not connected to the telex exchange
over the internet and subsequently delivers them when he is connected. Subscribers electing to make use of
the INSTORE facility must accept that:
SwissTelex Ltd. will not held responsible for non-delivery or mis-delivery of telexes arising from
any malfunction of the INSTORE facility.
The calling party will not be aware that the telex is held in an intermediate device for later delivery except by
examining the answerback sent to him by INSTORE. This answerback shall not be the subscriber's normal
answerback, but a text defined by the subscriber. SwissTelex Ltd. recommends that it should be as
stipulated in ITU Recommendation U.74 (Operational Provisions relating to Mailbox Devices connected to
the Telex Network).
(This answerback is for example "375106=TARG CH" instead of "375106 TARG CH")
When the subscriber connect to the Internet/Telex Gateway with WinTelex32, the Telex Exchange will detect
it and deliver any messages that are held in the INSTORE mailbox. The delivery will usually start in the next
two minutes after the connection.
This facility must be subscribed separately.

Manual Connection and Information Service
Connections to countries in which fully automatic Telex traffic is, at best, partially possible are established via the
international switchboard in Lugano (Tlx Nr. 141).
A short description of the procedure used to obtain a manual connection may be found in the official Telex
directory.
General information is provided by the information service (Tlx Nr. 111).

Memo-Telex, Memo-Plus
Memo-Telex is an efficient Store and Forward service for automatic Telex delivery. All Telex subscribers
registered in the exchange in Switzerland are able to use this service.
Memo-Telex is accessed via a non-chargeable service access code and is particularly suitable for messages
which require multiple attempts at delivery. Thus, it is especially useful for heavily used international circuits or
frequently occupied destinations. In addition, Memo-Telex provides a broadcast facility, such that a message,
once accepted, may be delivered to several destinations.
A maximum of 10 destinations may be defined for each message.
A short description may be found in the official Telex User Guide; Additionally, comprehensive operating
instructions may be requested from SWISSTELEX LTD Direction.
Memo-Plus is a further development of the Memo-Telex service. It offers numerous advantages, such as up to
25 prestored lists, containing a maximum of 50 destination addresses, for broadcasting a single message
(including the possibility of adding a personalised header text). Access to the service can be conducted either
with or without dialogue, so that this service is also suitable for users with an automatic installation.
The Memo-Plus service replaces, more or less, the automatic message delivery system SAM+, which was
abolished at the beginning of 1994. Memo-Plus is accessible (via Tlx# 130-133) following free registration. The
charges for using the service are the same as for Memo-Telex. Further information, as well as comprehensive
operating instructions may be requested from SWISSTELEX LTD Direction.

Telex Traffic with Mobile Destinations
The Telex service is available between Switzerland and mobile sea or land radio stations which are
correspondingly equipped. These stations may be installed on board ship or in vehicles. Alternatively, they
could be lightweight, easily portable stations which are usually installed temporarily in places with no connection
to the public telecommunication networks.
The connections are established either using short wave radio or via telecommunications satellite.
•

Connections with ships at sea via Bern Radio

•

Connections with ships at sea via MARITEX

•

Connections with mobile stations using satellites of INMARSAT

A short description of these services may be found in the official Telex directory.

Access to Other Telecommunication Services
Communication is not only possible with Telex subscribers, but also with subscribers of other telecommunication
services. Also accessible are:
•

The Fax connections of the USA and other countries.

•

The TELEPAGE Swiss subscribers

The special protocol and conventions required for communication between the Telex and Teletex services are
described in the official Telex directory. Information concerning the valid protocols to be used for communication
with other services are available from SWISSTELEX LTD Direction.

Product Support
SWISSTELEX Ltd.

Fault Reporting (WinTelex32)
Telephone national
international
Germany
Fax
national
international
Telex

0800 86 27 61
+41 31 932 36 77
+41 31 931 83 67
031 932 36 79
+41 31 932 36 79
(+45) 911020 edws ch

Email

wintelex.hotline@swisstelex.com

Fault Reporting (Telex Network)
Telephone national
international
Fax
national
international
Telex

091 961 60 11
+41 91 961 60 11
091 961 60 13
+41 91 961 60 13
(+45) 840148 txlu ch

Email

telex.switch@swisstelex.com

Web Site (News, Updates, etc ...)
http://www.swisstelex.com

Admin Program

Since WinTelex32 has been developed in accordance with the conventions for 32 bit Windows programs, all of
the program parameter values are stored in the Registry. Therefore, the program WinTelex32 Configuration
Administration has also been developed in order to verify these parameters and, if necessary, change them.
The program may be started by clicking Start and selecting Program Files/WinTelex32
Administration/WinTelex32 Configuration Administration.
You will now be asked to enter a password.
You may start the program without entering a password, but in this case you will only be able to verify the value
of the parameters: modifications will not be allowed. If the correct password is entered then you will be able to
modify the parameters.
The password is known to the system administrator.
The explanation of a few parameters, which may not be self-evident, are given below:
Enable EditFolder
If this is disabled, then the Symbol

is removed from the WinTelex-Manager. As a result it is no longer

possible to create user folders.
Enable FileDelete
is removed from the WinTelex-Manager. As a result it is no longer
If this is disabled, then the Symbol
possible to delete documents, since the menu entry "File/Delete" is also removed and the keyboard delete key
disabled.
Enable UserEnvVar
If this option is enabled, then the 'user abbreviation' of the first user to read an incoming Telex message will be
appended to the first line of the message (the first line is not part of the message text). This attachment (e.g. "
//NR") is displayed by the "WinTelex32-Manager", but can not be modified, since it is not displayed by the Editor.
However, the user abbreviation is printed with the message.
For each WinTelex32 user there must exist an environment variable, which is defined either in the file
AUTOEXEC.BAT or in the Novell Login Script, in the following format:
SET USER=XX
or
SET USER=John Smith

(where XX is an arbitrary user identification).
(Quotation marks must not be used !)

If this option is not enabled the field "UserEnvVar" is not displayed.
Enable SendErrLoop
Permits the infinite repetition of attempts to deliver a message in the event that the connection attempt fails due
to receipt of a negative service signal.
The service signals which allow infinite repetitions are: OCC, NP, ABS, DER, NA and NC.
Receipt of the following service signals generates an immediate failure and no further delivery attempts are
undertaken: NCH, FMT and INF.
Enabling this option is not recommended, as it occupies the telex line unnecessarily.
AllCapital
If your application (receipt and transmission) only operates with capitals then this option should be active.
On Server
If WinTelex32 runs on a server, you can suppress all message windows (except error messages at start).
Controller
If active, an assigned person as controller can not change the contents of a file; only move.
InTelexDir
All incoming telex messages are stored in this Windows folder.
OutTelexDir
In this Windows folder are stored all the other types of WinTelex32 files (Outgoing Telexes, templates, lists,
etc…).
TlxNumDir
WinTelex32 application provides the necessary tools to maintain a global telex number registry. This registry is
stored in this Windows folder. This folder could be, for example, a shared network path.
Subject
See the explanation for the paragraph "Subject Field " in Using the WinTelex-File Manager.
IP Connection (WinTelex IP only)
This shows the type of Internet connection used (Permanent, Dial-up, xDSL, etc…). This parameter cannot be

changed, it is defined when the installation is (pre-)configured.
OCC Retry
Defines the maximum number of call attempts, i.e. how many repetitions are made in the event of a connection
not succeeding due to reception of a service signal (OCC, NP, ABS, DER, NA and NC) The number can be
specified from 1 to 9. This option is only relevant if SendErrLoop is disabled (see above "Enable
SendErrLoop"). As soon as the specified number of call attempts has been reached the Telex message is
declared undeliverable and moved to the folder "Faulty Telex".
Receipt of the following service signals generates an immediate failure and no further delivery attempts are
undertaken: NCH, FMT and INF.
Scan Interval
Defines the time, in seconds, which must elapse between two passes of the "Scanner" utility.
On each pass the Scanner transmits any Telex messages which have been stored in the folder "Outgoing
Telex". If the installed version is "WinTelex32 TAG/TPI-S" the Scanner first checks whether any Telexes are
stored in the Modem memory or whether a connection is currently established. If so, these messages are first
read into the folder "Incoming Telex". In this case, it is recommended that the scan interval is set to a minimum
of 90 seconds.
This restriction does not apply to the Internet Version, since incoming Telexes are read directly to a free terminal
window.
PrintCopies
If Incoming or Outgoing telex messages must be printed, this option specifies how many copies of each are to
be printed.
HistoryDir
All incoming and outgoing telexes are listed in a history file called “History.INF” which is stored in this Windows
folder.
InTelexPrint
Enables or Disables the automatic printing of Incoming telex messages.
OutTelexPrint
Enables or Disables the automatic printing of Outgoing telex messages.
InToInR
If active, all incoming telexes are stored in the folder „Incoming & Read Telex“. It is recommended if you only
work with the printed document.
SuccessFull
If active, only successfully sent telexes are printed. Those which received a service signal are not (der, occ, nc
etc.).
Printer Choice
Defines which printer (for this subscriber Nr.) must be used to print the Incoming or Outgoing telex messages.
Network printers are supported.
Max Lines (WinTelex IP only)
Defines how many simultaneous virtual lines (connections via Internet) are allowed to this WinTelex32
installation. This parameter cannot be changed, it is defined when the installation is (pre-)configured.
NoScanLines (WinTelex IP only)
This defines the number of virtual lines that may NOT be used to run Scanners. A certain number of lines
(MaxLines - NoScanLines) are kept for receiving incoming telex calls and do not interfere with running scanners.
•
If your installation is configured for 1 MaxLine, then this parameter is 0 and incoming calls do interrupt
the scanner. The scanner start again when the incoming call is terminated.
•
If you have 2 or 3 MaxLines, this must be set to 1.

•

If MaxLines is set to more than 3, it must be minimum 1 and maximum MaxLines-2.

Idle Call minutes (only WinTelex overIP)
After how many minutes an established call should be cleared if there is no more traffic (receipt or transmission)
on the line.
NextInFileName
A sequence number that is assigned to the next received Telex message. It consists of a prefix (one or more
letters) followed by a number with a maximum of 8 digits (e.g. Incoming00000001, IN0001, or R0001). In the
event that the number range is exhausted, it restarts from 1 (e.g. IN9999 is followed by IN0001). In this case,
any new Telex messages in the folder with the same sequence number will be written as IN0001_01 etc.
NextOutFileName
As for NextInFileName but refers to outgoing Telexes.

WinTlxSurv Program
The "WinTelex32 TAG & TPI-S Survey Program" may be useful in the event that WinTelex32 has been
installed together with one or more TAG or TPI-S devices connected to the serial ports of a specific Telex-PC. It
is not necessary for a Gateway (IP) Installation, since the WinTelex32 Program should be always active.
Provided that a shortcut to this program is established in "Start->Program Files->Autostart" so that it is
automatically loaded whenever Windows is started, the program will continually supervise the Telex line(s) and
provide a warning message on receipt of a Telex message, even if the WinTelex32 Program is not active. It is no
longer necessary that the WinTelex32 Program is continually memory resident.
Of course, this program may be started manually at any time and may also co-exist with the WinTelex32
Program, even if this is currently active with message preparation, transmission, etc. The Survey Program
automatically resumes supervision of the Telex line(s) as soon as the main WinTelex32 Program has terminated.
Nevertheless, SwissTelex recommend that a shortcut be established in "Start->Program Files->Autostart".

Move
If you wish to move documents, then you must first select them and then, in the window "Copy/Move files", enter
the folder into which the document should be transferred. Click then on "OK".
Note:
As in most other Windows applications, you may select one file, a consecutive list of files (click on the first file
and then click on the last one while simultaneously holding the <Shift> key pressed) or a discrete list of files
(select any file while holding the <Ctrl> key pressed).

Copy
If you wish to copy documents, then you must first select them and then, in the window "Copy/Move files", enter
the folder into which the document should be copied. Click then on "OK".
Note:
As in most other Windows applications, you may select one file, a consecutive list of files (click on the first file
and then click on the last one while simultaneously holding the <Shift> key pressed) or a discrete list of files
(select any file while holding the <Ctrl> key pressed).

Archive
If you wish to archive documents, then you must first select them and then, in the window "Copy/Move files",
enter the folder into which the document should be archived. Click then on "OK".
A further requirement is the availability of a compression utility program (for example: PKZIP.EXE "). However,
this is not provided as part of the WinTelex Package and must be installed separately.
Note:
As in most other Windows applications, you may select one file, a consecutive list of files (click on the first file
and then click on the last one while simultaneously holding the <Shift> key pressed) or a discrete list of files
(select any file while holding the <Ctrl> key pressed).

Folder list
This dialog box displays the folders available to WinTelex. You may create new folders or existing folders may
be deleted or renamed. However, the first nine folders are system folders whose characteristics may not be
changed using the "Folder list" facilities.
Individual Telex messages may be moved or copied (resp. Archived) from one folder to another using "Drag &
Drop". That is, you first select the required Telex messages from the file list and then simply drag them using the
mouse (the left mouse button remains pressed) to the required folder, whereupon the left mouse button is
released.
Note:
As in most other Windows applications, you may select one file, a consecutive list of files (click on the first file
and then click on the last one while simultaneously holding the <Shift> key pressed) or a discrete list of files
(select any file while holding the <Ctrl> key pressed).

MS-Exchange Support
The MS-Exchange list displays those Telex messages which have been sent from the users via MS-Exchange to
the Gateway, and which are now ready for transmission via a telex line. The MS-Exchange application must be
started before WinTelex, since WinTelex establishes a link to MS-Exchange during its initialisation.

Any Files
This dialog box enables the management of files that have not been assigned to a WinTelex folder. You may
change directories or specify different selection criteria (e.g. *.txt or *.ini). However, note that this is a Telex
editor that only supports 69 characters per line. New line characters will be automatically inserted where
necessary when a file is opened.

Priority
Telex messages which have been assigned a priority are created with registration time "0.xx". They are thus
recognised as the oldest telex and will be transmitted first.

Special Message Features
Telex Message with Automatic Answerback Check
If you wish that the answerback of destination is verified before transmission of the Telex message then the
character string to be verified must be included in the first line of the message, enclosed in square brackets,
following the selection information.
Example: #911020 [911020 edws ch]
If it is only required to verify parts of the answerback then the various strings should be separated using a
semicolon character, e.g. [911; edws]. This method is essential when the destination is a collective number.
e.g. using [911020; edws ch] will ensure that both of the following answerbacks are accepted: "911020a edws
ch" and "911020z edws ch".

Telex Message with Deferred Delivery
If you wish that the transmission of a Telex message should be delayed, then the required date and time of
transmission, enclosed within round brackets, should be appended to the selection information on the first line of
the message.
Note:
Ensure that the system date and time of your PC is correct, since this determines when the delivery time has
been reached.
A few examples:
A telex message which should not be transmitted before 02.30AM on the 13th March 2007:
- #911020 ( 13/03/2007 02:30 )
or
#911020 ( 13 March 2007 02:30 )
A telex message which should not be transmitted before midnight on the 13th March 2007:

Automatic User Abbreviation Insertion
It is possible that larger companies, with a distributed network, may have several persons involved with Telex
Messages. In order that one knows who has read which Telex Message, it is possible to have a user
abbreviation automatically inserted as the first line of an "Incoming and Read Telex Message".
The same is true for outgoing Telex Messages. The user abbreviation of the Telex Message author is not
transmitted.
It is only possible to view the user abbreviation after having selected the document using the WinTelex-File
Manager. Alternatively, the user abbreviation is also included when the document is printed.
In order to enable this facility, the "Autoexec.bat" file must include the following line:
SET USER=XX
or
SET USER=John Smith

(where XX is user definable).
(Quotation marks must not be used !)

After restarting your computer, the WinTelex-File manager displays, at the bottom of the screen, the following
indication:

One now has the possibility to have displayed either All Telex Messages or only those containing your User
abbreviation.

Automatic Reference Number Insertion
In order to Increase the traceability of a Telex Message, (e.g. when the recipient has further inquiries to a
transmitted Message) the name of the .out file may be inserted in the Telex Message as a reference number.
In the event that the characters string REFNR: is present in the Telex Message, then the number of the .out file
will be automatically appended as a reference number.
This option can not be switched off. If it is desired to use a different reference number, then use a different
abbreviation.
A reference number insertion could take place as follows:
Ensure that you message contains the text "REFNR:"
E.g.:
"The following reference number, REFNR: , should be
quoted in any further communication in this matter."
The format of the transmitted message would be as follows:
THE FOLLOWING REFERENCE NUMBER, REFNR: S00345, SHOULD BE
QUOTED IN ANY FURTHER COMMUNICATION IN THIS MATTER.
The associated sequence number of the outgoing Telex is inserted in the message automatically.

The Internet Version of WinTelex32 also allows "*N" to be used instead of "REFNR:"
E.g.:
"The following reference number: *N , should be
quoted in any further communication in this matter."
In this case the transmitted text would be as follows:
THE FOLLOWING REFERENCE NUMBER: S00345, SHOULD BE
QUOTED IN ANY FURTHER COMMUNICATION IN THIS MATTER.

